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All information included in this document is current as of the date this document is issued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.
Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.
You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.
Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by
you or third parties arising from the use of these circuits, software, or information.
When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. You should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the development of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.
Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errors in or omissions from the information included herein.
Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as
indicated below. You must check the quality grade of each Renesas Electronics product before using it in a particular
application. You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not be in any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.
“Standard”:
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12.

Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots.
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anticrime systems; safety equipment; and medical equipment not specifically designed for life support.
“Specific”:
Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life.
You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with
applicable laws and regulations.
This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majorityowned subsidiaries.
(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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Windows is either a registered trademark or a trademark of Microsoft Corporation in the United States
and/or other countries.
• The information in this document is current as of March, 2010. The information is subject to change without notice. For actual
design-in, refer to the latest publications of NEC Electronics data sheets or data books, etc., for the most up-to-date
specifications of NEC Electronics products. Not all products and/or types are available in every country. Please check with an
NEC Electronics sales representative for availability and additional information.
• No part of this document may be copied or reproduced in any form or by any means without the prior written consent of NEC
Electronics. NEC Electronics assumes no responsibility for any errors that may appear in this document.
• NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual property rights of
third parties by or arising from the use of NEC Electronics products listed in this document or any other liability arising from the
use of such products. No license, express, implied or otherwise, is granted under any patents, copyrights or other intellectual
property rights of NEC Electronics or others.
• Descriptions of circuits, software and other related information in this document are provided for illustrative purposes in
semiconductor product operation and application examples. The incorporation of these circuits, software and information in
the design of a customer's equipment shall be done under the full responsibility of the customer. NEC Electronics assumes no
responsibility for any losses incurred by customers or third parties arising from the use of these circuits, software and
information.
• While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, customers agree
and acknowledge that the possibility of defects thereof cannot be eliminated entirely. To minimize risks of damage to property
or injury (including death) to persons arising from defects in NEC Electronics products, customers must incorporate sufficient
safety measures in their design, such as redundancy, fire-containment and anti-failure features.
• NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and "Specific". The
"Specific" quality grade applies only to NEC Electronics products developed based on a customer-designated "quality
assurance program" for a specific application. The recommended applications of an NEC Electronics product depend on its
quality grade, as indicated below. Customers must check the quality grade of each NEC Electronics product before using it in
a particular application.
"Standard": Computers, office equipment, communications equipment, test and measurement equipment, audio and visual
equipment, home electronic appliances, machine tools, personal electronic equipment and industrial robots.
"Special": Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster systems, anticrime systems, safety equipment and medical equipment (not specifically designed for life support).
"Specific": Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life support systems and
medical equipment for life support, etc.
The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC Electronics data
sheets or data books, etc. If customers wish to use NEC Electronics products in applications not intended by NEC Electronics,
they must contact an NEC Electronics sales representative in advance to determine NEC Electronics' willingness to support a
given application.
(Note 1) "NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its majority-owned
subsidiaries.
(Note 2) "NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as defined
above).
(M8E0909E)
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PREFACE

Target Readers

This manual is intended for users who use the WriteEZ5 when designing and
developing

a

system

using

an

NEC

Electronics

on-chip

flash

memory

microcontroller.
Purpose

This manual is intended to give users an understanding of the basic specifications
and correct use of the WriteEZ5.
By using the WriteEZ5, programs can be easily erased from or written to the flash
memory of an NEC Electronics on-chip flash memory microcontroller, or can be
verified on WindowsTM screens, while the microcontroller is mounted on the user
board.

Organization

This manual includes the following sections.
• Overview
• Operation using WriteEZ5
• Usage examples
• Troubleshooting

How to Read This Manual

To understand the overall functions and usage of the WriteEZ5, read this manual in
the order of the CONTENTS.
Be sure to read CHAPTER 2 OPERATION USING WriteEZ5 because this chapter
presents important information for using the WriteEZ5.
It is assumed that the readers of this manual have general knowledge of electricity,
logic circuits, and microcontrollers.
In the explanations of the operation of the applications, it is also assumed that the
readers have sufficient knowledge of Windows.
For the usage and terminology of Windows 2000, Windows XP, and Windows Vista
refer to each Windows manual.
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Conventions

Note:

Footnote for item marked with Note in the text

Caution: Information requiring particular attention
Remark: Supplementary information
Numeral representation:

Binary … ×××× or ××××B
Decimal … ××××
Hexadecimal … 0××××H or ××××H

Terminology

“ ”:
OK :

Any character or item on screen
Name of button

[ ]:

Menu

< >:

Dialog box name

The meanings of the terms used in this manual are as follows.
Term
Target device
Target system

Meaning
NEC Electronics on-chip flash memory microcontroller
User-designed board on which NEC Electronics on-chip flash
memory microcontroller is mounted
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CHAPTER 1 OVERVIEW

WriteEZ5 is simplified programming software for NEC Electronics All Flash 78K0, 78K0R, V850 microcontroller.
Programming environment can be made easily by adding digital circuit of simple serial communication to
microcontroller.
Refer to the sample digital circuit for reference on PDF files.
(Note: This sample circuit is an example. There is no guarantee of proper operation)

1.1

License Agreement

Before viewing or downloading the simplified programming circuit, simplified programming software, or this
document, you must read and accept the license agreement conditions below.
• The simplified programming circuit, simplified programming software, and this document are subject to change
without notice.
• NEC Electronics does not grant any guarantee or license regarding the intellectual property rights or other rights
of NEC Electronics or third parties when using the simplified programming circuit, simplified programming
software, or information in this document. NEC Electronics assumes no liability for the infringement of the rights
of third parties arising from the use of the above.
• The simplified programming circuit, simplified programming software, and information in this document are
provided for illustrative purposes in semiconductor product operation and application examples. Therefore, the
use of this information when designing equipment shall be done under the full responsibility of the customer.
NEC Electronics assumes no responsibility for losses incurred by customers or third parties arising from the use
of this information.

1.2

File Composition

• WEZ5_UM_e.pdf ...... This file
• WEZ5_MCU.pdf........ Support microcontrollers list
• WriteEZ5.exe ............ Simplified programming software
• wez5ctl.dll ................. Control DLL file
• Circuit folder.............. Simplified programming circuit

1.3

Operation Environment

• Windows2000/XP (32bit edition)/Vista (32bit edition)
Please use Windows by an administrator right.
• RS-232C port or the port changed from USB (2.0 or 1.1) to RS-232C
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1.4

System Configuration

The system configuration is as given in the diagram below.
Figure 1-1. System Configuration

WriteEZ5
Target device

Simplified programming

RS-232C or USB cable

circuit

Parameter file

Target system
Program file

1.5

About Parameter File

To use this program, parameter file that is defined timing and parameters for programming target flash
microcontroller is needed. Please download it from NEC Electronics website.
• NEC Electronics Microcontrollers website
http://www.necel.com/micro/en/ods/ --> Click "Version-up Service"
Please use the parameter file(PR5xxxx or PRMxxxx) on "WEZ5_MCU.pdf"

1.6

Usage

A summary of how to use WriteEZ5 is provided below. For details, refer to CHAPTER 2 OPERATION USING GUI
SOFTWARE, CHAPTER 3 USAGE EXAMPLE.
<1> Connect programming circuit to COM port on PC and then switch on PC
<2> Run WriteEZ5
<3> Select program file by [Load] command on [File] menu
<4> Select parameter file and COM port number and frequency by [Setup...] on [Device] menu
<5> Execute commands from [Device] menu
[Blank Check] command: Initiate a blank check of flash memory
[Erase] command: Erase data on flash memory
[Program] command: Program data on flash memory
[Verify] command: Transmits the specified user program to the target device and verifies the data written to
the flash memory
[Security] command: Program security flag of the target microcontroller
[Checksum] command: Read out the checksum from flash memory
[Autoprocedure(EPV)] command: Execute [Erase] and [Program] commands
[Signature read] command: Read out the signature information which is device name, flash memory
information and etc from flash memory
[Get Security settings] command: Read the settings for the security functions for the target microcontroller
and displays the result in the [Security flag settings] area on the [Advanced] tab in the Device Setup dialog.
<6> When each command terminate normally, display "...finish"

8
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1.7

Cautions

• In case of a RS-232C connection, check the cable type which you are using. (WriteEZ5 only supports straight
cable.)
• The Target reset message function is not supported for 78K0/Kx2-L.
• A programming error may occur on 78K0/Kx2-L depending on PC/OS/device drivers. If error occurs, please
do the followings.
<1> Program once again
<2> Use a different PC
• The speed of COM port that is selected on Device Setup window is fixed 115,200bps for 78K0 (Except
78K0/Kx2-L) and 78K0R. 78K0/Kx2-L is fixed 125,000bps.
• Select 9,800bps or 19,200bps or 38,400bps for the speed of COM port on Device Setup window for V850.

1.8

Others

• For users who use FT232 USB-Serial conversion chip made by Future Technology Devices International Ltd.
If programming speed is so slow, change below settings.
<1> Open the device manager window and select "Port(COM,LPT) --> USB Serial Port(COMx)"
<2> Select PortSettings tab on Properties window and select Advanced Settings.
<3> Set LatencyTime(msec) to "2" on Advanced Settings window.
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2.1

WriteEZ5 Main Window

• WriteEZ5 main window
When the WriteEZ5 is started normally, the following screen appears.
Figure 2-1. WriteEZ5 Main Window
Menu bar

Programmer parameter window

Toolbar

Action log window

Status bar

This window consists of the following items.
Name

Description of Display

Menu bar (displayed at the top)

Displays menu items executable by the
WriteEZ5.

Toolbar (displayed under the menu bar)

Displays frequently used commands as icons.

Action log window (displayed under the toolbar)

Displays an WriteEZ5 action log.

Programmer parameter window

Displays programming parameter settings.

(displayed to the right of the action log window)
Status bar

10

Displays status.
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2.2

Toolbar

The toolbar contains buttons to start the most important procedures of the WriteEZ5.
Table 2-1. Toolbar Buttons
[Device] – [Setup…] button

[File] – [Load…] button

[Device] – [Blank check] button

[Device] – [Erase] button

[Device] – [Program] button

[Device] – [Verify] button

[Device] – [Autoprocedure (EPV)] button

2.3

Menus

Depending on the actual device status or device type, some menu items may be enabled or disabled.
2.3.1

[File] menu

After clicking the [File] menu, the following pull-down menu is displayed.
Commands related to file operation appear here.
Figure 2-2. [File] Menu
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(1) [Load] command
The [Load] command allows you to select a program file.

The selected program file will be

programmed into the device’s flash memory by executing the [Program] command or [Autoprocedure
(EPV)] command.
Figure 2-3. HEX File Selection Window

The most recently used directory from which a file has been loaded will be offered in this window as the default
selection. After loading the user program, the checksum is calculated and the result is displayed in the
programmer parameter window.
[ Open button]
Selects a user program as a program to be written to the target device.
[ Cancel button]
Closes the window without selecting a program.
(2) [Quit] command
The [Quit] command terminates the WriteEZ5 WriteEZ5. Clicking the X button on the right side of the task
bar also terminates the WriteEZ5 WriteEZ5.
User settings are saved in the WriteEZ5.ININote file so that the WriteEZ5 will start up next time with the same
settings.
Note WriteEZ5.INI is created in the Windows folder.

12

User’s Manual U20265JJ1V0UM
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2.3.2

[Device] menu

Clicking the [Device] menu displays the following pull-down menu.
This pull-down menu mainly consists of commands for programming the target device, such as erase, program,
and verify.
Figure 2-4. [Device] Menu

(1) [Blank Check] command
The [Blank Check] command initiates a blank check of the target device. If the flash memory of the
target device is erased, the blank check terminates successfully.

If the flash memory is not

completely erased, “not blank” is displayed. Erase the flash memory of the target device before starting
programming.
(2) [Erase] command
The [Erase] command initiates the erase procedure for the target device.
While erasing the contents in the flash memory is in progress, the progress is displayed in the action
log window, indicating the operation of the programmer.
The [Blank Check] command that is executed before the [Erase] command is executed in accordance with the
setting of ‘Command options’ on the Advance tab of the [Device] > [Setup…] menu.
After completing the [Erase] command, the WriteEZ5 displays the target device command execution result.
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(3) [Program] command
The [Program] command transmits the specified user program to the target device and writes them to
the flash memory.
After execution of the [Program] command, verification to detect a communication error of the user program to
the target device is executed in accordance with the setting of ‘Command options’ on the Advance tab of the
[Device] > [Setup…] menu.
While programming is in progress, the progress is displayed in the action log window, indicating the operation
of the programmer. This progress indicates the progress of programming the target device as a percentage.
After completing the [Program] command, the WriteEZ5 displays the target device command execution result.
(4) [Verify] command
The [Verify] command transmits the specified user program to the target device and verifies the data
written to the flash memory of the target device.
While verification is in progress, the progress is displayed in the action log window, indicating the operation of
the programmer. This progress indicates the progress of verifying the target device as a percentage.
After completing the [Verify] command, the WriteEZ5 displays the target device command execution result.
(5) [Security] command
The [Security] command initiates the programming of the security flag of the target device. Set ‘Security flag
settings’ on the Advance tab of the [Device] > [Setup…] menu.
(6) [CheckSum] command
The [CheckSum] command initiates the reading of the checksum values of the target device. This value differs
from the value displayed in the parameter window in the main window.
(7) [Autoprocedure (EPV)] menu
The [Autoprocedure (EPV)] command sequentially executes the [Erase] and [Program] commands
explained above.
After execution of the [Autoprocedure (EPV)] command, to verify the checksum values of the data written to the
flash memory of the target device and the program file to detect a communication error of the user program
while it is being transmitted, specify automatic execution of the [CheckSum] command after execution of the
[Program] command, using the Command options on the Advance tab of the [Device] > [Setup…] menu.
During EPV, the progress status of the programmer operation is displayed in the action log window. Refer to
CHAPTER 5 USAGE EXAMPLE for the selected command, and its execution operation and message.
After completing the [Autoprocedure (EPV)] command, the WriteEZ5 displays the target device command
execution result.
(8) [Signature read] command
The [Signature read] command reads the target signature information (such as device name and flash memory
information).
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(9) [Get Security settings] command
The [Get Security settings] command reads the Security flag information of the target device, and reflects the
result in the Advanced Setup menu.
When this menu can be specified, be sure to check the security by executing the [Get Security settings]
command immediately before the security command is executed, and specify any additional security.
Figure 2-5. Device Setup Window − Advance Tab

(10) [Setup…] command
The [Setup…] command is used to perform flash memory writing settings in accordance with the
user environment, and command option settings. Each time the WriteEZ5 is started, the parameter
file (.PRM) that were used last are read, and their setting contents are displayed. Settings can be changed in
accordance with the user environment, except for the parameters that are dimmed.
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(a) Standard setup
This menu is used to set the rewriting environment of the target device’s flash memory.
The mode of communication with the target device and the operating clock of the device differ depending
on the device used. Refer to the manual of the device used for details.
The following window opens.
Figure 2-6. Device Setup Window – Standard Tab

This window shows all basic options that can be set in accordance with the user environment and target
device.
[ OK button]
Saves the settings in the Standard and Advance tabs and closes the window.
[ Cancel button]
Closes the window without saving the settings in the Standard and Advance tabs.
<1> Parameter file
This file holds parameters and timing data required to rewrite the flash memory of the target device.
Do not modify the data in the parameter file because the data is related to the guarantee of rewrite
data.
The parameter file is protected by the checksum function. If the checksum result indicates an error,
the WriteEZ5 does not accept the parameter file.
Figure 2-7. Device Setup Window – Parameter File Selection
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Figure 2-8. Parameter File Selection Window

[ PRM File Read button]
A window for specifying a parameter file is displayed. Specify the target file and click Open .
<2> Host connection
Select the communication channel for host machine, in this area.
Figure 2-9. Device Setup Window – Host Connection

[Port box]
Select the communication channel for host machine.
• COM1 to COM256
Remark

The selectable port can be checked with the Device Manager.

[Speed box]
Select the communication rate of the communication channel.
• 9,600 bps
• 19,200 bps
• 38,400 bps
• 115,200 bps
• 125,000 bps
Remark

78K0R and 78K0 (Except 78K0/Kx2-L) are fixed 115,200 bps. 78K0/Kx2-L is fixed
125,000 bps.
For V850, select 9,800 bps, 19,200 bps, or 38,400 bps.
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<3> Supply oscillator
Under [Supply oscillator], set up the clock to be supplied to the target device.
Figure 2-10. Device Setup Window – Supply Oscillator

[Frequency box]
Sets the clock frequency of the target system.
Remark

For details about which communication speeds can be entered, see the user's manual for
your device.

[Multiply rate]
Sets the division rate or multiplication rate of the target device.
If the target device includes the PLL circuit, input the division rate or multiplication rate depending on
the environment used.
Since the division rate or multiplication rate varies depending on the device, set it by checking the
device specifications.
If the target device does not include the PLL circuit, select “1.0”.
The default setting is displayed by the parameter file in the initial screen.
<4> Operation Mode
The flash memory may be divided into blocks or areas depending on the target device.
This menu is used to select the operation mode of the flash memory. Some devices do not have
either or both division modes Block and Area. In this case, a mode that is not available cannot be
selected.
Figure 2-11. Device Setup Window – Operation Mode Selection

[When Chip is selected]
The entire flash memory area of the target device is subject to rewrite processing.
[When Block is selected]
Specify the Block number range subject to rewrite processing by using Start/End.
The Start/End list boxes display the Block number where the flash memory of the target device is
configured.
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[When Area is selected]
Specify the Area number range subject to rewrite processing by using Start/End.
The Start/End list boxes display the Area number where the flash memory of the target device is
configured.
[Show Address check box]
Specifies whether numbers or addresses are displayed in the Start/End list boxes.
If this check box is checked, addresses are displayed.
If it is not checked, numbers are displayed.
<5> Target Reset Message
By checking the Target Reset Message check box, the window promoting the reset operation
manually is displayed even when the reset signal cannot be connected to the target cable.
Figure 2-12. Device Setup Window − Target Reset Message

Caution

The Target reset message function is not supported for 78K0/Kx2-L.

Remark

The Target Reset Message check box is common to Standard and Advance tabs.

User’s Manual U20265JJ1V0UM

19

CHAPTER 2 OPERATION USING WriteEZ5

(b) Advance setup
This menu is used to specify command options and security flag setting.
The Advance tab is displayed by clicking Advance.
Figure 2-13. Device Setup Window – Advance Tab

<1> Command options
Specify the options for the WriteEZ5 flash processing commands in this area.
Figure 2-14. Device Setup Window – Command Options

[Blank check before Erase check box]
If this check box is checked, a blank check is performed before execution of the [Erase] and
[Autoprocedure (EPV)] commands. If the result of the blank check is OK, erase processing is not
executed.
[Read verify after Program check box]
If this check box is checked, the written data is transmitted from the programmer, and verification is
executed with the data written to the flash memory after execution of the [Program] and
[Autoprocedure (EPV)] commands.
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[Security flag after Program check box]
If this check box is checked, automatic programming of the selected security flag is executed after
execution of the [Program] and [Autoprocedure (EPV)] commands.
[Checksum after Program check box]
If this check box is checked, the flash memory checksum values of the target device are read from
the target device after execution of the [Program] and [Autoprocedure (EPV)] commands.
This value differs from the value displayed in the parameter window in the main window.
[Wide Voltage mode check box]
Select whether to write data in the wide voltage mode.
If this check box is selected, data is written in the wide voltage mode.
If this check box is not selected, data is not written in the wide voltage mode.
<2> Security flag settings
The <Security flag settings> dialog box is used to specify which security function is valid. For details
about each security feature, see the user's manual for your device.
Figure 2-15. Device Setup Window – Security Flag Settings

[Disable Chip Erase check box]
If this check box is checked, the [Erase] command becomes invalid in the entire flash memory area
of the target device.
At this time, the warning message shown below is displayed.
Figure 2-16. Device Setup Window – Disable Chip Erase Warning

Caution

Be aware that if the security flag is set in the target device, neither erasing nor
writing to the device can be enabled afterward.

[Disable Block Erase check box]
If this check box is checked, the [Erase] command becomes invalid in all the blocks of the flash
memory selected under Operation Mode in the Standard Setup menu.
This setting is cleared by the [Erase] command when Chip was selected under Operation Mode.
User’s Manual U20265JJ1V0UM
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[Disable Program check box]
If this check box is checked, the [Program] command becomes invalid, as does the [Erase] command
in all the blocks of the flash memory selected under Operation Mode in the Standard Setup menu.
The [Erase] command for the entire flash memory area is valid.
This setting is cleared by the [Erase] command when Chip was selected under the Operation Mode.
[Disable Read check box]
If this check box is checked, the [Read] command Note becomes invalid.
This setting is cleared by the [Erase] command when Chip was selected under the Operation Mode.
Note WriteEZ5 does not support the [Read] command.
[Disable Boot block cluster reprogramming check box]
If this check box is checked, the boot area is set with the boot block set in the Boot block cluster
setting as the last block.
At this time, the warning message shown below is displayed.
Figure 2-17. Device Setup Window − Disable Boot Block Cluster Reprogramming Warning

Caution

Be aware that if the security flag is set in the target device, the boot area cannot be
rewritten to the device afterward.

[Reset vector box]
If an address is entered, the reset vector is changed to the specified address. Note that this setting is
cleared by the deletion command when “Chip” is selected under the Operation Mode. The initial value
is 000000h.
[Boot Block end list box]
If the [Disable Boot block cluster reprogramming] check box is selected, also select the block number
from the [Boot Block end] list box. This list box shows the block numbers where the flash memory in
the target device is set up.
[FS Block start/FS Block end list box]
For the flash shield window feature, select the blocks to specify for the [FS Block start] and [FS Block
end] list boxes. This feature makes it possible to write only in the specified range during flash
memory self-programming. This feature has no effect on writing performed by a programmer.
Because it is not possible to write outside the specified range, accidental writing can be prevented
during flash memory self programming.
These list boxes show the block numbers the block numbers where the flash memory in the target
device is set up. The entire flash area is selected by default.
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[Show Address check box]
Specify whether to display numbers or addresses in the [Boot Block end], [FS Block start], and [FS
Block end] list boxes. If the [Show Address] check box is selected, addresses are displayed. If the
check box is not selected, block numbers are displayed.
<3> Target Reset Message
By checking the Target Reset Message check box, the window promoting the reset operation
manually is displayed even when the reset signal cannot be connected to the target cable.
Figure 2-18. Device Setup Window − Target Reset Message

2.3.3

Caution

The Target reset message function is not supported for 78K0/Kx2-L.

Remark

The Target Reset Message check box is common to Standard and Advance tabs.

[View] menu

Clicking the [View] menu displays the following pull-down menu.
This menu consists of commands for setting whether to display the toolbar and status bar.
Figure 2-19. [View] Menu

(1) [Toolbar] command
Checking the [Toolbar] command displays the toolbar. Unchecking the command hides the toolbar.
(2) [Status Bar] command
Checking the [Status Bar] command displays the status bar. Unchecking the command hides the status bar.
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2.3.4

[Help] menu

Clicking the [Help] menu displays the following pull-down menu.
Figure 2-20. [Help] Menu

(1) [About WriteEZ5…] command
The [About WriteEZ5…] command opens the following program entry window and indicates the version.
Clicking OK terminates the display.
Figure 2-21. About WriteEZ5 Window
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This chapter explains a series of basic operations of the WriteEZ5, taking a case where the μPD78F0588 is used
as the target device as an example. This chapter covers how to start the system, execute the [Autoprocedure (EPV)]
command, and program the target device.
Refer to CHAPTER 2 OPERATION USING WriteEZ5 for the other commands and applications.
The conditions of the series of operations described in this chapter are as follows.
• Target system
Target device:

μPD78F0588

Voltage level:

5V

Communication:

UART

Simplified writing circuit:

FT232BM, which is manufactured by FTDI (and uses an FTDI driver)

• WriteEZ5
Parameter file:

78F0588.prm

Clock setting:

None (Internal OSC)

Port:

COM5 (125,000 bps)

Operation mode:

Chip

Write HEX:

sample.hex

Option setting:

Blank check before Erase

(1) Preparing the hardware and software
Prepare WriteEZ5, the parameter file, the simplified writing circuit, and the target system in which the
microcontroller is installed as described in CHAPTER 1 OVERVIEW. Use an RS-232C or USB cable to
connect the target system to a computer, and then turn the target system on. Next, obtain and install any
necessary drivers.
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(2) Starting the WriteEZ5
Start the WriteEZ5.
Figure 3-1. GUI Software Main Window

(3) Setting the programming environment
<1> Select [Device] → [Setup] from the menu bar.
<2> The Standard tab of the Device Setup window for device setup is activated.
Figure 3-2. Device Setup Window – Standard Tab
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<3> Click PRM File Read to open the parameter file selection window.
In this case, select the parameter file for the μPD78F0588, then click Open .
Figure 3-3. Parameter File Selection

<4> Set the items in the Host connection, Supply oscillator, Operation Mode fields so that the WriteEZ5 is
adjusted to the user programming environment.
Here, assume that the settings shown below are set.
Figure 3-4. Device Setup Window – Standard Tab <After Setting>

Remark

The selectable port can be checked with the Device Manager.
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<5> Switch to the Advance tab.
Figure 3-5. Device Setup Window – Advance Tab

<Command options>
Blank check before Erase: Checked
<Security flag settings>
These settings are not used in this example.
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<6> Click OK . The WriteEZ5 sets the parameters.
When the settings are completed, the following screen is displayed.
Figure 3-6. Completion of Parameter Setting

“PRM File Read OK.” is displayed

Parameters are updated.
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(4) Selecting a user program
<1> Select [File] → [Load].
<2> Select a program file to be written to the target device, then click Open .
Figure 3-7. After Loading File

“Success read HEX file.” is displayed.

Parameters are updated.

(5) [Autoprocedure (EPV)] command execution
Select [Device] → [Autoprocedure (EPV)] from the menu bar.
When the [Autoprocedure (EPV)] command is executed, [Erase] → [Program] are executed sequentially for the

μPD78F0588. In this example, “Blank check before Erase” is checked. So, blank check is performed before
the execution of the [Autoprocedure (EPV)] command.
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Figure 3-8. After EPV Execution

“...finish” is displayed.

(6) Terminating the system
<1> If other devices need not be programmed, select [File] → [Quit] to terminate the WriteEZ5.
All settings executed so far are saved in the WriteEZ5.INI file, so that those settings can be reused when
the WriteEZ5 is restarted.
<2> Power off the target system.
(7) Restart
When the system is restarted, the same screen as shown in Figure 3-6 appears.
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(1) Communication with the target device is not possible.
Cause:
The driver may not be installed correctly.
Action:
Open the Device Manager window and check that the drivers are installed normally.
Cause:
The port list box may not be set correctly.
Action:
Set the port confirmed with the Device Manager.
Cause:
The RS-232C cable might not be straight.
Action:
Use a straight cable.
Cause:
There may be an incorrect connection between the digital circuit and target device.
Action:
Check if the connection is correct.
Pay special attention to the following connections because the connections are confusing:
Connect TXD of the digital circuit to RXD of target device
Connect RXD of the digital circuit to TXD of target device
Cause:
The power or clock may not be supplied to the target device correctly.
Action:
<1> Check that the clock is supplied in the target system.
<2> Check that the power is supplied in the target system.
Cause:
The parameter file selected in the Device Setup window may be incorrect.
Action:
Use a parameter file that matches the target device.
Refer to 1.5 About Parameter File and CHAPTER 2 OPERATION USING WriteEZ5 for information about
parameter files.
Cause:
The supply oscillator setting selected in the Device Setup window may be incorrect.
Action:
Set the supply oscillator that matches the target device specifications and environment used.
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Cause:
The speed list box setting selected in the Device Setup window may be incorrect.
Action:
Set the speed list box correctly by checking the user’s manual for the target device.
Cause:
The power supply capacity of the USB port of the personal computer may be low.
Action:
Try using another personal computer or supply power from the target system.
Cause:
Security may be set.
Action:
Check that security is not set.
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